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2 BRINGING PHOTOS INTO 
LIGHTROOM CLASSIC

Lesson overview
Lightroom Classic allows a great deal of flexibility when importing 
photos: you can download them directly from a camera, import them 
from an external drive, or transfer them between catalogs on separate 
computers. During the import process, you can organize folders, add 
keywords and metadata to make your photos easier to find, make 
backup copies, and even apply editing presets. In this lesson, you’ll 
learn how to:

•  Import images from a camera or card reader.

•  Import images from a hard disk or removable media.

•  Evaluate images before importing.

•  Organize, rename, and process images automatically.

•  Implement a backup strategy.

•  Set up automatic importing and create import presets.

•  Acquire images from other catalogs and applications.

This lesson will take about 1 to 2 hours to complete. To get the lesson 
files used in this chapter, download them from the web page for this 
book at adobepress.com/LightroomCIB2022. For more information, see 
“Accessing the lesson files and Web Edition” in the Getting Started section 
at the beginning of this book.
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Lightroom Classic helps you to begin organizing 
and managing your growing photo library. From the 
moment you click the Import button; you can make 
backups, create and organize folders, inspect images 
at high magnifi cation, and add keywords and other 
metadata that will save you hours of sorting and 
searching your image library later—and all this 
before your photos even reach your catalog! 
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Getting started
Before you begin, make sure you’ve set up the LRC2022CIB folder for your lesson 
files and downloaded the lesson02 folder from your Account page at peachpit.com 
to the LRC2022CIB\Lessons folder, as described in “Accessing the lesson files and 
Web Edition” in the “Getting Started” section at the start of this book. Also, be sure 
you have created the LRC2022CIB Catalog file to manage the lesson files, as detailed 
in “Creating a catalog file for working with this book,” also in the “Getting Started” 
section.

1 Start Lightroom Classic. In the Select Catalog dialog box, make sure that 
LRC2022CIB Catalog.lrcat is selected, and then click Open.

2  Lightroom Classic will open in the screen mode and workspace module  
that were active when you last quit. If necessary, switch to the Library module  
by clicking Library in the Module Picker at the top of the workspace.

Lightroom is your digital notebook
Before we begin, I want to share with you an analogy that I think helps explain what 
Lightroom does in terms of organization. I’ll come back to this analogy from time to 
time throughout the book.

Imagine you are sitting at home when someone knocks on the door and gives you  
a box of pictures. They ask you to store the pictures for safekeeping, so you take the 
box into your home and place it on top of your desk in the living room. In order to 

E Tip: If you can’t 
see the Module Picker, 
choose Window > 
Panels > Show Module 
Picker, or press the F5 
key. If you’re working 
on macOS, you may 
need to press the fn 
key together with the 
F5 key, or change the 
function key behavior in 
the system preferences.
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remember where you placed those pictures, you pull out a notebook and write down 
that they are in a box on the desk in the living room.

There’s another knock at the door, and another box of pictures appears. You take 
these pictures and place them inside one of the drawers in your bedroom. You want 
to remember where they are, so you write it down in your notebook. More boxes 
of pictures appear, and you continue to place them in different areas of your house, 
writing down the location of each box of pictures in your notebook—there are a lot 
of boxes of pictures, and you don’t want to forget! 

That notebook becomes the central record of where the boxes of pictures are stored 
in your home.

Now, imagine that you’re bored one day while at home, and you take the pictures 
that are in the box on top of the desk in the living room and place them in a par-
ticular order. You want to make a note of this change, so you write down in your 
notebook that the pictures on top of the desk in the living room have been orga-
nized in a specific fashion.

The notebook you’ve been using serves as the master record of the location of each 
box of pictures inside your home, as well as a record of all of the changes you’ve 
made to each picture.

That notebook is your Lightroom catalog—your Lightroom catalog is a digital note-
book that keeps track of where your images are and what you have done to them.

Lightroom doesn’t store your images; it stores information about your images in 
the catalog. This catalog includes a ton of information about each image (or video), 
including where the file lives on your drives; the camera settings at capture; any 
descriptions, keywords, ratings, and so on, that you apply in Lightroom’s Library 
module; and a running list of every edit you make in Lightroom’s Develop module.

When you think of your Lightroom catalog, just think of a digital notebook that’s 
keeping track of where you put your pictures and what you are doing with them.

The import process
Lightroom Classic has a number of options for importing your images. You can 
import directly from a digital camera or card reader, your hard disk, or any external 
storage media, or you can transfer them from another Lightroom catalog or from 
other applications. You can import at the click of a button, use a menu command, 
or simply drag and drop. Lightroom can launch the import process as soon as you 
connect your camera, or import automatically whenever you move files into a speci-
fied folder. Wherever you’re acquiring photos from, it will be important to become 
familiar with the Import dialog box.
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54 LESSON 2 Bringing Photos into Lightroom Classic

The top section of the Import dialog box presents the basic steps in the import pro-
cess, arranged from left to right: choose an import source, specify how Lightroom 
is to handle the files you’re importing, and then—if you choose to copy or move 
the source files—set up an import destination. If these are all of the details that you 
require to import the images, you can leave the dialog box set to compact mode. To 
access even more information, you can click the triangle at the lower left to expand 
to the full dialog box.

In expanded mode, the Import dialog box looks and works like the Lightroom 
Classic workspace modules. The Source panel at the left accesses your files on any 
available drive. The Preview area in the center displays images from the source 
as thumbnails in Grid view or enlarged in Loupe view. Depending on the type of 
import, the right panel group offers a Destination panel that mirrors the Source 
panel, and a set of controls for processing your images while they’re being imported.
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Importing photos from a digital camera
While this next section outlines the process of importing from a camera pretty 
clearly, I recommend that you try this with some sample images of your own. Take 
your camera and make 10–15 images of anything, really, just have something on  
the memory card that we can use for the import process.

The first step is to ensure the Lightroom preferences are set so that the import 
process is triggered automatically whenever you connect your camera or a memory 
card to your computer.

1 Choose Lightroom Classic > Preferences (macOS)/Edit > Preferences (Windows). 
In the Preferences dialog box, click the General tab. Under Import Options, 
select Show Import Dialog When A Memory Card Is Detected.

Some cameras generate folder names on the memory card. If you don’t find these 
folder names helpful for organizing your images, select Ignore Camera-Generated 
Folder Names When Naming Folders. You’ll learn more about folder naming 
options later in this lesson.

2  Click the Close button or OK to close the Preferences dialog box.

3  Connect your digital camera or card reader to your computer, following the 
manufacturer’s instructions.

4  This step may vary depending on your operating system and the image manage-
ment software on your computer:

•  In Windows, if the AutoPlay dialog box or settings pane appears, select the 
option to open image files in Lightroom Classic. If you wish, you can set this 
option as the default.

•  If you have more than one Adobe image management application—such 
as Adobe Bridge—installed on your computer and the Adobe Downloader 
dialog box appears, click Cancel.

•  If the Import dialog box appears, continue to step 5.
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•  If the Import dialog box does not appear, choose File > Import Photos And 
Video, or click the Import button below the left panel group.

5  If the Import dialog box appears in compact mode, click the Show More Options 
button at the lower left of the dialog box to see all of the options in the expanded 
Import dialog box.

The top panel of the Import dialog box—visible in both the compact and expanded 
modes—presents three steps in the import process, arranged from left to right:

•  Selecting the source location of the images you wish to add to your catalog.

•  Specifying how you want Lightroom to handle the files you’re importing.

•  Setting the destination to which the image files will be copied, with the option 
to choose any develop presets, keywords, or other metadata that you would like 
applied to your photos as they are added to your catalog below this panel.

 y

Your camera or memory card is now shown as  
the import source in the FROM area at the left 
of the top panel and under Devices in the Source 
panel at the left of the Import dialog box.

Depending on your computer setup, it’s possible 
that your camera’s memory card will be recog-
nized as a removable storage disk. If this is the 
case, you may see some differences in the options 
available in the Import dialog box, but it shouldn’t 
affect anything.

6  If your memory card is listed as a removable 
disk—rather than a device—in the Source 
panel, click to select it from the Files list and 
make sure that Include Subfolders is selected.

7  From the import type options in the center of 
the top panel, choose Copy, so that the photos 
are copied from your camera to your hard disk 
and then added to your catalog, leaving the 
original files on your camera’s memory card.

P Note: If your mem-
ory card is recognized 
as a removable disk, the 
Move and Add options 
may not be disabled as 
illustrated here and on 
the next page; these 
import options are 
discussed later in this 
lesson.
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Lightroom displays a brief description of the action that will be taken for whichever 
option is currently selected.

8  Move your pointer over each of the options shown in the bar across the top of 
the Preview pane to see a tool tip describing the option. For this exercise, leave 
the default All Photos option selected and don’t click the Import button yet.

A checkmark in the upper-left corner of an image cell indicates that the photo will 
be imported. By default, all of the photos on your memory card will be selected for 
import. If you do not want to import an image, you can exclude it by clicking its 
checkbox to deselect it.

You can select multiple images and then change all of their checkmarks simultane-
ously. To select a contiguous range of images, select the first image in the range by 
clicking the thumbnail or the surrounding image cell, and then hold down the Shift 
key and select the last image in the series. To select individual additional images, 
Command-click/Ctrl-click their thumbnails. Click the checkmark of any selected 
image to change the import status for the entire selection.

E Tip: Use the slider 
below the preview pane 
to change the size of 
the thumbnails.Sam
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Notice that at the top of the import dialog, Copy is selected rather than Add. Keep 
in mind that, during the import process, Lightroom does not actually import the 
image files themselves; it only adds entries to the Lightroom catalog to record their 
locations. Because you’re copying the files, you’ll need to specify a destination.

If you selected Add rather than Copy, you wouldn’t have to specify a destination 
folder; the photos would stay where they are already stored. However, because 
memory cards are expected to be erased and reused, they should not be the 
permanent home for your pictures. Thus, you’re not offered the Add and Move 
options when you import from a camera—Lightroom expects to copy your photos 
from your memory card to a more permanent location.

The next step, then, is to specify a destination folder to which your photos should  
be copied. This is the time to give some thought to how you intend to organize  
your photos on your hard drive. For now, leave the Import Photos dialog box open; 
you’ll choose a destination folder and deal with the rest of the import options in  
the following exercises.

Organizing your copied photos in folders
By default, Lightroom tries to organize your images in the Pictures folder. You can 
choose any other location, but as a general rule, it is a good idea to keep all of your 
images organized into one location—no matter where that is. Nailing down that 
location (or workflow) early will help a ton in finding missing images (we’ll talk 
about the workflow later in the book).

Before beginning the lessons in this book, you created a folder named LRC2022CIB 
inside your Users/use r n a m e /Documents folder on your computer. This folder already 
contains subfolders for your LRC2022CIB Catalog file and for the image files used 
for the lessons in this book. For the purposes of this exercise, you’ll create another 
subfolder inside the LRC2022CIB folder as the destination for the images that you 
import from your camera’s memory card:

1 In the right panel group of the Import dialog box, 
collapse the File Handling, File Renaming, and 
Apply During Import panels; then, expand the 
Destination panel.

2  In the Destination panel, navigate to and select 
your LRC2022CIB folder; then, click the plus  
sign (+) button at the left of the Destination 
panel header and choose Create New Folder 
from the menu.

3  In the Browse For Folder/Create New Folder 
dialog box, navigate to and select your 
LRC2022CIB folder, if it’s not already selected. 
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Click the New Folder button, type Imported From Camera as the name for your 
new folder, and then click Create (macOS) or press Enter (Windows).

4  Make sure the new Imported From Camera folder is selected in the Browse For 
Folder/Create New Folder dialog box, and then click the Choose/Select Folder 
button to close the dialog box. Note that the new folder is now listed and 
selected in the Destination panel.

The name of the new destination folder also  
appears in the TO area at the right of the top  
panel of the Import dialog box.

The Organize menu, near the top of the Destination panel, offers various options to 
help you organize your photos into folders as you copy them onto your hard disk:

•  Into One Folder With the current settings, the images would be copied into  
the new Imported From Camera folder. Instead, you could select Into Subfolder 
to create a new subfolder for each import from your camera.

•  By Date: [Date Format] These options are all  
variations on organizing your photos by capture 
date. Your images would be copied into one or  
more subfolders, depending on your choice of  
date format. Choosing the format “2021/10/03” 
for example, would result in one folder per year, 
containing one folder per month, containing one 
folder per day for each capture date. Or, choosing 
2021 October 03 simply creates one folder per 
date, as shown in the illustration at the right.

Think about which system of folder organization 
best suits your needs before you import photos from 
your camera, and then main tain that system for all 
your camera imports.

5  For the purposes of this exercise (and what  
I recommend to everyone as a default), choose 
Into One Folder from the Organize menu.

6  Select the Into Subfolder option at the top of 
the panel, type Lesson 2 Import in the adjacent 
text box as the new subfolder’s name, and press 
Return/Enter. The subfolder should then appear 
inside the folder you chose in the bottom section 
of the Destination panel.

P Note: If your 
memory card has been 
recognized as a remov-
able disk, you may also 
see the Organize option 
By Original Folders; this 
option will be discussed 
later in this lesson.
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Review Questions
1 Review uses Number List

About file formats
Camera raw formats Camera raw file formats contain unprocessed data from a digital camera’s 
sensor. Most camera manufacturers save image data in a proprietary camera format. Lightroom reads 
the data from most cameras and processes it into a full-color photo. You can use the controls in the 
Develop module to process and interpret the raw image data for your photo. For a list of supported 
cameras and camera raw formats, see https://helpx.adobe.com/photoshop/camera-raw.html.

Digital Negative format (DNG) The Digital Negative (DNG) file format is a publicly available archival 
format for raw files generated by digital cameras. DNG addresses the lack of an open standard for raw  
files created by individual camera models, ensuring that photographers will be able to access their files  
in the future. You can convert proprietary raw files to DNG in Lightroom. For more information about 
the Digital Negative (DNG) file format, visit https://helpx.adobe.com/photoshop/digital-negative.html.

TIFF format Tagged-Image File Format (TIFF, TIF) is used to exchange files between applications and 
computer platforms. TIFF is a flexible bitmap image format supported by virtually all paint, image-
editing, and page-layout applications. Also, virtually all desktop scanners can produce TIFF images. 
Lightroom supports large documents saved in TIFF format (up to 65,000 pixels per side). However, 
most other applications, including older versions of Photoshop (pre-Photoshop CS), do not support 
documents with file sizes greater than 2 GB. The TIFF format provides greater compression and indus-
try compatibility than Photoshop format (PSD) and is the recommended format for exchanging files 
between Lightroom and Photoshop. In Lightroom, you can export TIFF image files with a bit depth of 
8 bits or 16 bits per channel.

JPEG format Joint Photographic Experts Group (JPEG) format is commonly used to display photo-
graphs and other continuous-tone images in web photo galleries, slideshows, presentations, and 
other online services. JPEG retains all color information in an RGB image but compresses file size by 
selectively discarding data. A JPEG image is automatically decompressed when opened. In most cases, 
the Best Quality setting produces a result indistinguishable from the original.

Photoshop format (PSD) Photoshop format (PSD) is the standard Photoshop file format. To import 
and work with a multi-layered PSD file in Lightroom, the file must be saved in Photoshop with the  
Maximize PSD and PSB File Compatibility option activated. You’ll find this option in the Photoshop  
file handling preferences. Lightroom saves PSD files with a bit depth or 8 bits or 16 bits per channel.

PNG files Lightroom imports PNG files, but transparency is not supported; it will appear white.

CMYK files Lightroom imports CMYK files, but edits and output are performed in the RGB color space.

Video files Lightroom will import video files from most digital cameras. You can tag, rate, filter, and  
include video files in collections and slideshows. Video files can be trimmed, and also edited with most 
of the Quick Edit controls. Click the camera icon on the video file’s thumbnail to launch an external 
viewer such as QuickTime or Windows Media Player.

File format exceptions Lightroom does not support the following types of files: Adobe Illustrator® 
files, Nikon scanner NEF files, files with dimensions greater than 65,000 pixels per side or larger than 
512 megapixels.

Note: To import photos from a scanner, use your scanner’s software to scan to TIFF or DNG format.
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Review Questions
1 Review uses Number List

Creating import presets
When you import photos on a regular basis, you’ll probably find that you’re setting up the same 
configurations of options over and over. Lightroom Classic enables you to streamline your import 
workflow by saving your preferred settings as import presets. To create an import preset, set up your 
import in the expanded Import dialog box, and then choose Save Current Settings As New Preset 
from the Import Preset menu below the Preview pane.

Type a descriptive name for your new preset, and then 
click Create.

Your new preset will include all of your current set-
tings: the source, import type (Copy as DNG, Copy, 
Move, or Add), file handling and renaming options, develop and metadata presets, keywords, and 
destination. You might set up one preset to move photos from a memory card to your computer, and 
another preset to import from a memory card to a network-attached storage device. You could even 
create separate import presets tailored to the characteristics of different cameras, so you can quickly 
apply your favorite noise reduction, lens correction, and camera calibration settings during the import 
process, saving yourself time in the Develop module later.

Using the Import dialog box in compact mode

Once you’ve created the presets you need, you can speed up the process even more by using the 
Import dialog box in compact mode, where you can use your import preset as a starting point and 
then change the source, metadata, keywords, and destination settings, as required. 
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Backup strategies
Your next choice is whether to make backup copies of the images from your camera 
at the same time as Lightroom creates primary copies in the location you’ve just 
specified and adds them to the library catalog. For some, it’s a good idea to create 
backup copies on a separate hard disk or on external storage media so you don’t lose 
your images if your hard disk fails or you accidentally delete them.

1 In the right panel group of the Import dialog box, expand the File Handling 
panel and select the Make A Second Copy To option.

2  Click the small triangle 
to the right and select 
Choose Folder to specify a 
destination for your backup 
copies.

3  In the Browse For Folder/ 
Choose Folder dialog box, navigate to the folder in which you wish to store the 
backup copies of your images, and then click Choose/Select Folder.

Keep in mind that the purpose of this backup is mainly as a precaution against loss 
of data due to disk failure or human error during the import process; it’s not meant 
to replace the standard backup procedure you have in place—or should have in 
place—for the files on your hard disk.

For the most part, I don’t use this backup option, but rely instead on a combina-
tion of my computer’s backup system (Time Machine) and the use of my network-
attached storage device. This is part of my personal workflow strategy, which I’ll 
share with you and explain later on in the book.

Renaming files as they are imported
The cryptic filenames created by digital cameras are not particularly helpful  
when it comes to sorting and searching your photo library. Lightroom can help by 
renaming your images for you as they are imported. You can choose from a list of 
predefined naming options or create your own customized naming templates.

1 In the right panel group of the 
Import dialog box, expand the  
File Renaming panel and select 
Rename Files. Choose Custom 
Name - Sequence from the 
Template menu, type a descriptive 
name in the Custom Text box,  
and then press the Tab key on  
your keyboard. A sample name at the bottom of the File Renaming panel shows 
how your settings will be applied for the first image imported. You can enter 

E Tip: An option you 
should consider, if it’s 
supported by your cam-
era, is to set the camera 
to generate filenames 
with unique sequence 
numbers. When you 
clear your memory card, 
or change memory 
cards, your camera will 
continue to  generate 
unique sequence 
numbers rather than 
starting the count from 
one again. This way, the 
images you import into 
your library will always 
have unique filenames.
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a number other than 1 in the Start Number text box; this is useful if you’re 
importing more than one batch of images from the same shoot or series (often 
from multiple memory cards).

2  Click the small triangle to the right of the Custom Text box; your new text has 
been added to a list of recently entered names. You can choose from this list if 
you import another batch of files that belong in the same series. This not only 
saves time and effort, but helps you ensure that subsequent batches are named 
identically. To clear the list, choose Clear List from the menu.

3  Choose Custom Name (x of y) from the Template menu. Note that the sample 
name at the bottom of the File Renaming panel is updated to reflect the change.

4  Choose Edit from the Template menu to open the Filename Template Editor. 
Choose Custom Name - Sequence from the Preset menu.

In the Filename Template Editor dialog box, you can set up a filename template that 
makes use of metadata information stored in your image files—such as filenames, 
capture dates, or ISO settings—adding automatically generated sequence numbers 
and any custom text you specify. A filename template includes placeholders—or 
tok e n s—that will be replaced by actual values during the renaming process. A token 
is highlighted in blue on macOS and framed by curly brackets on Windows.

You could rename your photos  
vacation_images-20211004-0001, and 
so on, by setting up a filename template 
with a custom text token, a date token, 
and a four-digit sequence number token, 
separated by typed hyphens, as shown at 
the right. Let's remove the Custom Text 
token by selecting and deleting it. 

5  Choose Save Current Settings As  
New Preset from the Preset menu  
at the top.

6  Type Date and 4 Digit Sequence for 
your preset name, click Create, and 
then click Done.

Despite all of the options available for 
renaming your images during the import process, there’s only so much information 
you can squeeze into a single filename. While you may be tempted to be descriptive 
in your filenames, consistency is key for your archive, and the more streamlined you 
keep it, the better. This simple organization of dates and sequences in the actual files 
will pay off in speed and efficiency. Lightroom’s strength is in its ability to find your 
images through the use of things like metadata, keywords, and collections. In these 
areas, you can be a lot more descriptive than the limited confines of the filename. 

E Tip: For more 
information on using 
the Filename Template 
Editor, please refer to 
Lightroom Help.
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Review Questions
1 Review uses Number List

Tips for naming your files and folders
We’ve talked about the importance of naming your files and folders to better organize your photos, 
and I gave you an example of how to name them. Here are some tips and suggestions for renaming:

• Name your files and folders similarly to make it easier to find the photos you want later.

• Start the name of every file with the year, then add a month and day.

• Use lowercase when naming your files and folders. 

• If you believe it is necessary, add a descriptive word about the shoot after the date, and keep it as 
short as possible.

• If you need to add a space in your name, use 
an underscore (_) instead of a space.

• At the end of the filename, add C1, C2, C3, 
and so on, for card 1, card 2, card 3. This helps 
when you have a shoot that spans multiple 
memory cards.

For example, if I want to import images that I took 
of my family on October 4, 2021, my folder would 
be named 20211004_family. If I only shot one card 
during that shoot, the filename would be 20211004_family_c1_sequential file number. Is the filename 
long? Yes. Does it give you all of the information about the shoot? Absolutely.

Here’s the practical reason for adding the C1 to 
your filenames: Every now and then, during a 
Lightroom import, you will run into a file that 
looks like the one here. While it may make for an 
interesting art project, it’s actually something a lot 
more sinister. It is a corrupt picture, a quick sign 
that the card you used may not be as reliable as 
you thought. Memory cards, like everything else, 
can fail over time, and you cannot afford to lose an 
important shoot because of it. If you are importing 
from multiple cards, how do you tell which one is 
the bad one?

As soon as I purchase a memory card, I make it a point to label it using those C numbers. Then, I add 
that C number to the filename. The moment I see a potential problem with an image, I can look at  
the name and know exactly which card failed, so I can take that card out of rotation…and give it to  
a friend. Kidding! Simply labeling your memory cards and adding that C1 or C2 to your filenames can 
go a long way to helping you troubleshoot. Anal? Yes. Vital? Absolutely.
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You’ll learn about working with metadata, keywords, and collections in the follow-
ing exercises and in Lesson 4, “Managing Your Photo Library.”

6  For now, click Import if you wish to bring your photos into the LRC2022CIB 
catalog or Cancel to close the Import dialog box without importing any images.

You have now completed this exercise on importing photos from a digital camera or 
a memory card. You’ll learn about the other options that are available in the Import 
dialog box in the exercises to follow.

Importing images from a hard disk
When you import photos from your hard disk or from external drives, Lightroom 
Classic offers you more options for organizing your image files than are available 
when importing from a camera.

You can still choose to copy your images to a new location during the import pro-
cess, as you did in the previous exercise, but you also have the option to add them 
to your catalog without moving them from their current location. You might choose 
to do this if the images you wish to import are already well organized in a folder 
structure on your drive.

For images that are already located on your hard disk, you have an extra option: to 
move them to a new location and remove them from their original location at the 
same time as they are added to your catalog. This option might appeal if the images 
on your hard disk are not already well organized.

1 To import the images for this exercise from your 
computer hard disk, either choose File > Import 
Photos And Video, press Shift+Command+I/
Shift+Ctrl+I, click the Import button below the 
left panel group in the Library module, or drag 
the folder onto Lightroom’s Library module.

2  In the Source panel at the left of the Import 
dialog box, navigate to the Lessons folder inside 
the LRC2022CIB folder on your hard disk. 
Click the lesson02 folder and select Include 
Subfolders at the upper right of the panel (it’s 
best to leave this on unless you have some 
images you don’t want to import).

An image count in the lower-left corner of the 
Import dialog box shows that the lesson02 folder 
contains a total of 13 photos with a combined file 
size of 71 MB.

E Tip: The same 
commands apply for 
importing images from 
a CD, DVD, or other 
external storage media.
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3  From the import type options in the center of the top panel, click Add so that 
your photos will be added to your catalog without being moved—an option that 
is not available when importing images from a camera. Do not click Import yet!

4  Use the scrollbar at the right of the Preview pane to view all of the images in the 
lesson02 folder. Drag the Thumbnail slider below the Preview pane to the left to 
reduce the size of the thumbnails so that you can see as many of the images as 
possible in the Preview area.

5   In the Source panel, notice the Include Subfolders option. This checkbox allows 
you to add images from within subfolders, which is handy to have with larger 
image collections you may be importing.

Before we go any further, let’s review each of the import type options above the 
Preview area.

6  Click each of the import type options in turn, from left to right:

•  Copy As DNG will have Lightroom make copies of your images in DNG 
(digital negative) file format, which will be stored in a new location and then 
added to your catalog. You’ll notice that for the Copy As DNG, Copy, and 
Move options, the right panel group offers the same suite of panels—File 
Handling, File Renaming, Apply During Import, and Destination.
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•  Click Copy to have Lightroom create copies of your images in a new location, 
and then add them to your catalog, leaving the originals in their current 
locations. You can set a destination for your copies in the Destination panel, 
as you did in the previous exercise. Expand the Destination panel and click 
the Organize menu. When you use either the Copy As DNG, Copy, or Move 
option to import images from your hard disk or from external storage media, 
the Organize menu offers you the option to copy your photos into a single 
folder, into subfolders based on the capture dates, or into a folder structure 
that replicates the original arrangement.

•  Click Move to have the images moved to a new location on your hard disk, 
arranged in whatever folder structure you choose from the Organize menu, 
and then deleted from their original locations.

•  Click Add to add the images 
to your cat alog without mov-
ing or copying them from 
their current locations or 
altering the folder structure 
in which they are stored. For 
the Add option, the right 
panel group offers only the 
File Handling and Apply 
During Import panels; you 
cannot rename the original 
source images during import, 
and there’s no need to specify 
a destination because the 
files remain where they are.

P Note: Expand the 
File Handling and Apply 
During Import panels 
to see the options 
available.
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Applying metadata
Lightroom uses information attached to files to enable you to quickly find and orga-
nize your photos. This information is known as metadata. Some of this metadata is 
automatically added to the file at the point of creation (shutter speed, ISO, camera 
type, and so on), and some of it can be added after the fact (keywords, your name, 
and so on).

You can search your image library and filter the results by all of this metadata, as 
well as things like flag status, color label, shooting settings, or any combination of  
a wide range of other criteria.

You can also choose specific information about your images from this metadata and 
have Lightroom display it as a text overlay applied to each image in a slideshow, web 
gallery, or print layout.

Let’s add some important information into our files quickly, and make sure we don’t 
have to reinvent the wheel every time. For this, we’ll use metadata presets.

1 In the Apply During Import panel, choose New from the Metadata menu.

2  Let’s create a metadata preset that includes your copyright information in each 
file. In the New Metadata Preset dialog box, for Preset Name, type Copyright 
Info [year]. Then, enter your copyright information into the IPTC Copyright 
fields and contact information into the IPTC Creator fields. This should give 
anyone online enough information to get a hold of you should someone find 
your image interesting and want to use it. It does happen at times.

P Note: Remember 
that any image that is 
shared with metadata 
online can be read by 
anyone online. While 
adding your email 
address and website are 
totally fine, do not put 
in any more personal 
information, such as 
your home address or 
phone number. That 
information in the 
wrong hands could be 
bad, so leave it out! Sam
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